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This installation guide details the installation and configuration of Worktop 2.1,
and contains the following chapters:

Chapter 1, �Introduction,� provides an introduction to Worktop 2.1.

Chapter 2, �To install Worktop 2.1,� provides detailed information on how to
install Worktop 2.1.

Chapter 3, �To configure Worktop 2.1,� provides detailed information on how to
configure Worktop 2.1 with Worktop documents.

Chapter 4, �Central Deployment,� details how to use Worktop 2.1 in a central
deployment environment.

Chapter 5, �To uninstall Worktop 2.1,� provides detailed information on how to
uninstall Worktop 2.1.

Chapter 6, �Troubleshooting,� provides some troubleshooting tips.

If you have any additional questions after you read this installation guide, send
an e-mail to worktop@baan.com. Your questions will be answered as soon as
possible.

About this document

mailto:worktop@baan.com
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Worktop 2.1 is a Windows-based application and must be installed on a machine
before use. After installation, at least one Worktop document must be created or
copied onto that machine before an end user can start to work with Worktop.

The main difference between Worktop 2.1 and Worktop 2.0 is that Worktop 2.1
supports Central Deployment. To apply Central Deployment, install Worktop 2.1
on one central server and create Worktop documents on that machine. End users
can use these Worktop documents from their own machine without having
Worktop or BW installed. Chapter 4, �Central Deployment,� describes in detail
how to set up such a Central Deployment environment. You are strongly
recommended to read this chapter carefully if you want to use Worktop in this
environment.

Definitions, acronyms and abbreviations
Term Description

DEM Dynamic Enterprise Modeler

ERP Enterprise Resource Planning
%WINDOWSROOT% Location in which Windows is installed, for

example, C:\winnt.
% BWROOT% Location in which BW is installed, for example,

C:\Program Files\Baan
%WORKTOPROOT% Location in which Worktop is installed, for

example, C:\Program Files\Baan\Worktop
UNC Uniform Naming Convention, for example, if (on a

machine called cnl05410) C:\Program Files is
shared under the name Programs, the UNC is
\\cnl05410\Programs

wtd file Worktop document
gct file GUI configuration template
sct file Server configuration template
CD Central Deployment
COM Common Object Model

1 Introduction



Introduction

Installation Guide
1-2

References
Document Abbreviation
BaanERP 5.0c Central Deployment for DEM and Baan
Windows

[CD_DEM_BW]

Worktop 2.1 User Manual [WT_UM]
BaanERP Windows Client Installation Guide [WCIG]
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This chapter covers the installation of Worktop 2.1. The following topics are
addressed:

� System requirements.
� Preinstallation steps.
� To run the setup Wizard.
� To start Worktop.

If you use Worktop in a Central Deployment environment, the installation and
configuration slightly differs from the usual installation and configuration
procedure. Therefore, you are strongly recommended to first read Chapter 4,
�Central Deployment,� which describes how to set up a Central Deployment
environment in detail.

System requirements
The machine on which Worktop 2.1 is installed requires the following hardware
and software:

Hardware
� Pentium 90 MHz.
� 32 Mb memory.
� VGA display adapter.
� 20 Mb hard disk space.

Client Software
� Windows 95/98/NT 4.0/2000.
� Baan Windows.
� To start FOS sessions: FOS client.
� To start SCS sessions: SCS client.
� To view URLs, help texts, and to use Drag-and-Relate: Internet Explorer 4.0

or later.

2 To install Worktop 2.1
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Baan Server Software
One of the following:

� BaanERP 5.0c SP4* or later.
� BaanERP 5.2a or later.
� To use Drag-and-Relate: a BDN 2.5 server.
� To use the Baan Process Browser: DEM.

*Together with BaanERP 5.0c SP4, a BaanERP 5.0c SP3 Tools Patch CD is
distributed. This update is required to run Worktop on SP4.

Preinstallation steps
Before you install Worktop, you must install Baan Windows and create a BWC
(Baan Windows Configuration) file to connect to the Baan server on which you
want to work with Worktop. You must install BW as Worktop uses BW to
integrate the Menu Browser and to launch Baan sessions.

You can install Worktop first and install Baan Windows and a BWC file later on.
But you must do this before you start to use Worktop.

After you create the BWC file(s), you must specify authorizations. Open the
BWC file to run Baan Windows. Open the User Data (ttaad2500m000) session,
open the details session of the Baan user and click on the second tab. Select the
checkbox in front of the Worktop Tree group, and select each of the
components for which the user who uses Worktop must be authorized. Note that
although a third component called Baan Workflow can exist, Worktop 2.1 does
not support Baan Workflow. Do not forget to click Convert Changes to
Runtime DD on the Specific menu in the User Data overview session after you
modify these entries and to close BW before you continue.



To install Worktop 2.1

Installation Guide
2-3

In the remainder of this section, three session examples are displayed that show
how the Worktop authorization can be changed on different Baan versions.

Example 1  To change Worktop authorization on BAAN IVc4

Example 2  To change Worktop authorization on BaanERP 5.0c
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Example 3  To change Worktop authorization on BaanERP 5.2a
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To run the Setup Wizard
The installation of Worktop 2.1 has a Wizard that guides you through the
installation process. To install Worktop 2.1, take the following steps:

1 Insert the Worktop 2.1 CD in the CD-ROM drive. If the installation wizard
does not start automatically or if you want to install Worktop from a share,
double-click or start setup.exe.

2 Click Next in the Welcome screen to continue the setup.
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3 Read the License agreement and click Yes if you agree; the setup continues.
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4 If you have not yet installed a Worktop version onto this client, continue with
Step 5. If you did install a Worktop version onto this client before and did not
uninstall it, continue with Step 6.

5 Select the folder in which you want to install Worktop. Click Browse to
select a different folder from the default folder, which is
C:\Program Files\Baan\Worktop. Continue with Step 7.
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6 As you already installed Worktop, this setup overwrites the old version. Click
Next to overwrite the current Worktop installation with this version. To
install Worktop in a different folder, exit this setup and uninstall Worktop
first (this is discussed in Chapter 4, �Central Deployment�).
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7 The Worktop installation is finished. Click Finish to end the setup.
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To start Worktop
To start Worktop, on the Start menu, point to Programs\Baan Worktop. In this
group, you find the Worktop application and a readme file. Click Worktop to
run Worktop.

When you run Worktop for the very first time, the Worktop directly opens the
document Wizard that allows you to create a new Worktop document.
In Chapter 3, �To configure Worktop 2.1,� this Wizard is discussed.

NOTE
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You can configure Worktop 2.1 by creating Worktop documents. A Worktop
document holds all server configuration and UI configuration information and is
the actual Worktop working environment. The first section of this chapter
provides the conversion of Worktop documents created by earlier Worktop
versions. The second section details how to create a new Worktop document in
Worktop 2.1. The third section describes how to change server configuration
settings of an existing document.

To convert old Worktop documents
In Worktop 2.0, you can open Worktop documents created by Worktop 1.0.
Worktop 2.1 does not support loading Worktop documents created in earlier
versions, as many changes have been made to the architecture of Worktop
documents.

To create a new Worktop document
To create a new Worktop document, which is the basis of an end users working
environment, click New on the File menu in the Worktop application. Note that
if this is the very first time you start Worktop, the Wizard appears automatically.

3 To configure Worktop 2.1
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To create a Worktop document, the Wizard guides you through the following
steps:

1 Click Next in the Welcome screen.
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2 Select the Baan Configuration (BWC file) you want to use in this Worktop
document. After you select the Baan Configuration, click Next.

You must have created this BWC file before you start Worktop (refer to
�Preinstallation steps,� in Chapter 2). Whenever you modify a BWC file, you
must reload the document in which this BWC file is used before these
changes have effect. If you create a new BWC file, you must restart Worktop
to see this BWC file in this step of the Wizard.

After you click Next, the following warning message can appear:

If this is the case, refer to �Preinstallation steps,� in Chapter 2, to give a user
Worktop authorization before you continue.

NOTE

NOTE



To configure Worktop 2.1

Installation Guide
3-4

3 If this user has no Worktop authorization for the Baan Process Browser
(DEM) application, the Wizard continues with Step 4.

Select the DEM company you want to work on in the left area of the dialog
box. After you select the DEM company, all Version\Project
Model\Optimization Phase combinations for which the user is authorized
appear in the right area of the dialog box. Select the combination you want to
use in this Worktop document. After you select both the DEM company and
Project Model\Version\Optimization Phase combination, click Next.

Sometimes the user has Worktop authorization to use the Baan Process
Browser, but the administrator did not configure the corresponding DEM
employee correctly. For example, the employee is not be linked to a DEM
employee at all or has no roles. In that case, an error message appears that
indicates the problem and both columns are filled with the text Not Available.
You can continue by clicking Next, but the user cannot use the Baan Process
Browser.

NOTE
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4 To enable the Drag-and-Relate functionality, select the Enable Drag-and-
Relate checkbox. Specify the host name, port number, and login of the BDN
server you want to use. Specify the mode you want to start HyperRelational
data in (see the user manual). Click Finish to finish the creation of a new
Worktop document.

The Host and Port number can be entered automatically. This is the case
whenever this is performed in the Baan Data Navigator � Parameters
(ttgfd4124m000) session on the Baan server. To specify the host name and
port number of the BDN server, open this session and enter the host name
and port number separated by a colon (:), as shown in the following example:

Only if the host name and port number are filled in correctly in this session
and these settings are used in the Worktop document, the Start as Baan
Session mode is enabled (The Baan server must know the parameters of the
BDN server to support running Baan sessions with HyperRelational data).

NOTE
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To change server configurations of an
existing Worktop document
A Worktop document holds many different types of server configurations. You
can change these server configurations for an existing document in the following
ways:

� To modify the Baan Windows Configuration
To change the contents of a BWC file, use BECS. As soon as you reload the
Worktop document in which this BWC file is used, these changes are
automatically applied by Worktop.

� To use a new Baan Windows Configuration
To use a newly-created BWC file you must always create a new Worktop
document. The BWC file that is used is selected during the creation of the
document and cannot be changed afterwards.

� Changes in Project Model
If changes are made in the Project Model you use in a Worktop document,
Worktop automatically applies these changes when the document in which
this Project Model is used is opened. The changes can also be applied at
runtime by refreshing the Baan Process Browser in the Worktop application.

� To use different DEM Company, Version, Project Model or
Optimization Phase
To use a different DEM Company, Version, Project Model, or Optimization
Phase, you must always create a new Worktop document. These parameters
are selected during creation of the Worktop document and cannot be changed
afterwards.

� To change Drag-and-Relate settings
To change Drag-and-Relate server configuration settings of an existing
Worktop document, open the document first. On the Tools menu, click
Options, and modify the server configuration settings on the Drag-and-
Relate tab.
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Introduction
Worktop 2.1 supports Central Deployment. If you use Worktop this way, this
offers a lot of advantages, mainly for system administrators who now only have
to install, configure, and maintain one system instead of all end-user machines.
Generally, the advantages are:

� No client-side installation or automatic installation and update.

� Global access (only if Windows NT/2000 is used with roaming Profiles).

� The administrator can create Worktop document templates, and the end user
does not have to configure anything.

� Although personalization is supported, end users cannot change
configurations reserved by the administrator.

The following section details how to set up a Central Deployment environment.
Chapter 1, �Introduction,� provides some additional technical details and features
that are useful for system administrators. Chapter 6, �Troubleshooting,� contains
a list of often encountered problems, most of which are configuration issues. If
you encounter any problems with Worktop, refer to this chapter.

Worktop server versus Worktop client
In a Central Deployment environment, Worktop is installed on one machine.
This installation can be used by any other client, by launching the Worktop
executable shared on that machine. The machine on which Worktop is installed
is referred to as the Worktop server. Any other machine from where Worktop is
run, but on which Worktop is not installed, is referred to as a Worktop client.

Furthermore, running a Worktop server indicates that Worktop is run on the
Worktop server, while running a Worktop client indicates that Worktop is run on
a Worktop client.

4 Central Deployment
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System requirements
The system requirements for a Worktop server are exactly the same as described
in Chapter 1, �Introduction.� The only difference with regard to system
requirements for a Worktop client is that on this client Worktop and BW do not
both have to be installed.

General remarks
If you want to use Worktop in a Central Deployment environment, you must note
the following:

� How to use spaces in names
Sharenames and BWC files must never contain spaces, or Worktop simply
does not work on the Worktop client. However, you can use spaces in
Worktop document names.

� How to use a system both as Worktop server and Worktop client
If you use a system as a Worktop server as well as a Worktop client, you can
encounter serious connection problems. The problem occurs when you run
the Worktop client and open a Worktop document with a remote BWC file
that has the same name as a local BWC file. In this case, the Worktop
documents that use this BWC file fail to create a Baan connection.

You are strongly recommended to:

− Either not use a system both as Worktop server and Worktop client, or
always prefix the BWC files created on a machine with the name of the
machine, which associates a BWC file with the system it was created on.
For example, a BWC file created on a system called cnl05410 that
connects to a Baan server called Runner is named cnl05410_runner.bwc.

− Give read-only permission to the location in which the BWC files are
stored. This prevents end users from modifying the BWC files on the
Worktop server.

� Local administrator rights required
As Worktop uses COM to communicate with the Baan server, Worktop needs
to register some components in the Windows registry. To do so, local
administrator rights are required. Therefore, to be able to use Worktop:

− Either the end user must have local administrator rights.

− Or the administrator must have opened Worktop and the Worktop
document that will be used on that machine before.
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� Error logging
Worktop will store all error or warning messages in a file called wtError.log.
This file is located in the Application Data\Baan\Worktop\log directory of the
users profile. When the Worktop server is not configured well, this log file
often contains useful information to determine the cause of the problem.

� To Modify BWC files outside BECS
Whenever you modify, rename, move, or delete BWC files outside BECS,
this causes the BWC file to be registered incorrectly. Although BW will still
run, Worktop cannot use the BWC file anymore, as it uses the Baan
Automation part of BW that must be registered correctly.

� Authorization of server user and client user differs
If the administrator creates a Worktop document, they must use a Baan login
that has some specific component authorization. Now, if the Worktop
component authorization of this user (so Menu Browser and/or Baan Process
Browser access) differs from the authorization of the end user�s Baan login,
the end user is notified about this fact each time they open the document.
Baan recommends to create Worktop documents for a group of users that all
have the same authorization with regard to the Worktop components.

To set up a Central Deployment environment
This section details how to set up Worktop 2.1 in a Central Deployment
environment. Take the following steps to set up a Worktop server:

1 Install Baan Windows
First of all, install Baan Windows on this machine. Note that each BW
version on BaanERP is always backwards compatible, and therefore, for
example, a BaanERP 5.2a BW can be used in combination with a
BaanERP 5.0c server.

2 Copy Baan Windows files
To use BW in a Central Deployment environment, you must copy the
contents of %WINDOWSROOT%\Baan\bin to %BWROOT%\bin. Windows
asks you whether you want to overwrite the files already present in the
directory. Click Yes to all (this does not matter, as the duplicate files are
exactly the same).
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3 Share the Baan Windows directory
You must give the users that will use Worktop read access permission to BW.
Therefore, share the %BWROOT% directory. You are strongly
recommended to give only read access permission, no write permission. If
end users have write access, they can mix up your BWC configuration files
on the server.

The share name may not contain any spaces, or Worktop will not work in a
Central Deployment environment.

For more information on how to use BW in a Central Deployment
environment, refer to [CD_DEM_BW] and [WCIG] (for the meaning of these
abbreviations, refer to Chapter 1, �Introduction�).

4 Configure Baan Windows
Create BWC files that you will use in the Worktop documents. Note that you
probably want to leave the user name and password fields empty, as all users
will use this BWC file and must log on with their own account.

The names of the BWC files may not contain any spaces, or Worktop will
simply not work in a Central Deployment environment.

5 Install Worktop
Install Worktop as detailed in Chapter 2, �To install Worktop 2.1.�

6 Share the Worktop directory
After installation, you must at least give read permission to those end users
who will use Worktop; therefore you must share the %WORKTOPROOT%
directory.

Do not use spaces in the share name, or Worktop will not work in a Central
Deployment environment.

7 Configure Worktop
Now you can create Worktop documents as exactly the same way as
discussed in �To create a new Worktop document� in Chapter 3. However,
for Central Deployment the big difference is that this document can also be
used by multiple end users. Whenever an end user opens a Worktop
document from the Worktop server for the very first time, it is copied to the
users profile and the user can personalize the document and save it. The
Worktop document created on the Worktop server is actually a template. All
settings (such as shortcuts and visible or hidden panes) are initially available
to all end users.

NOTE

NOTE

NOTE
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A very important note is that although users are allowed to personalize their
Worktop documents, they cannot change server configuration settings. You
can only change these settings on the Worktop server. This is supported by
automatically disabling the following options in Worktop whenever Worktop
is run on a client:

−−−− New on the File menu.

−−−− Save as on the File menu.

−−−− Host name and Port number entry on the Drag-and-Relate tab in the
Tools\Options dialog box.

8 Changing policies
Consider disabling the options for end users to configure the bwc file and to
save their password. How to do this is discussed in more detail in the
documents [CD_DEM_BW] and [WCIG].

9 Running Worktop
After installation, two Worktop-related executable files are located in the
%WORKTOPROOT%\bin directory on the Worktop server: Worktop.exe
and Worktop_client.exe. If you want to run the Worktop server, you must run
Worktop.exe on the Worktop server (usually, you launch Worktop from the
Start menu). Note that you do not need to run Worktop to allow Worktop
clients to connect to this Worktop server, as no services are required.

To run a Worktop client, browse to the \bin subdirectory of the Worktop
share on the client machine. For example, if a Worktop server called
cnl05259 has shared the Worktop directory with the name �Worktop,� open
Explorer on the client machine and browse to \\cnl05259\Worktop\bin. This
folder contains two executables, Worktop.exe and Worktop_client.exe. To
run the Worktop client, you can run either of the following:

− Worktop.exe
No Worktop-related files are stored on the local machine but these files
will be loaded into memory. When you close Worktop, the memory is
released. The advantage of this method is that no Worktop files (except
for the personal documents) are stored on the client. The disadvantage is
that each time you start Worktop, the Worktop-related files must be
transferred from the Worktop server to the clients memory, which causes
significant network load.
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− Worktop_client.exe
If an end user runs Worktop_client.exe, initially only a very small
executable is transferred from the Worktop server to the client. The first
time this executable runs, it copies the Worktop-related files to the
%WINDOWSROOT%\ Application Data\Baan\Worktop directory. After
that it runs Worktop.exe from this directory. Any other time, it checks
whether some files are missing and whether the Worktop server contains a
different version of Worktop from the client. In both cases, the client is
updated. This method is recommended, as the network load is
significantly less and Worktop has a faster startup time on the client.

10 Distribution of Worktop documents
After the installation and configuration of Worktop, you probably want to
distribute the Worktop documents to the end users. The easiest way to do this
is by sending a shortcut to Worktop_client.exe with the document as startup
parameter. Take the following steps:

−−−− Create a shortcut to Worktop_client.exe; right-click on
Worktop_client.exe in Explorer and select Create Shortcut.

−−−− Now right-click on the shortcut you created and select Properties.

−−−− On the Shortcut tab, in the Target field, add the UNC name (for the
meaning of this abbreviation, refer to �Definitions, acronyms and
abbreviations� in Chapter 1) of the document to be opened after the path
to the Worktop_client executable. Therefore, the syntax will be
<Worktop_client path> <Worktop document UNC path>.

−−−− Attach the shortcut to an e-mail message and send it to all end users.

Technical details
Worktop documents
Worktop 2.1 documents are separated in three parts:

� Worktop document (.wtd file).
� Server configuration template (.sct file).
� GUI configuration template (a .gct file).

The two templates are saved in the %WORKTOPROOT%\templates directory
directly after you create a Worktop document. A Worktop document is only a
pointer to two of these templates, the only information contained by a Worktop
document is what sct and gct file you must use.
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When an end user opens a Worktop document for the first time, the
corresponding gct file is copied from the server to the users profile, in the
..\Application Data\Baan\Worktop\documents directory. The next time the users
open the Worktop document, Worktop finds this gct file in the users profile and
uses that one instead of the one located on the server. The user has write access
to the local gct file, but not to the gct and sct files on the server. The sct file is not
copied to the client, but is always read from the server.

As the gct and sct files really separate GUI settings and server settings, you can
reuse them. For example, if you created a document with a lot of shortcuts and
want to create a second document with the same GUI settings, but different
server settings, you can either modify the reference in the Worktop document to
the other gct file, or overwrite the gct file.

Transparency of documents
Worktop documents (not the templates) can be copied and opened anywhere, as
it contains pointers to the UNC name of the corresponding templates. Therfore,
for example, you can create a Worktop document on the Worktop server with the
name �test.wtd� and copy it to your local machine and open it from there.
Worktop reads from the test.wtd file to which it points to the templates on the
Worktop server and loads these templates.

Desktop shortcuts
When Worktop is launched for the first time on a machine, a shortcut to the
Worktop executable is automatically created on the desktop. End users can start
Worktop the next time by activating the shortcut, and Worktop automatically
opens the last opened document.

However, the automatic creation of these shortcuts is a default, which you can
also change. The %WORKTOPROOT% directory on the Worktop server
contains a file called Worktop.ini, which holds administrator settings. By default,
the AutoShortcut field is set to 1. If this field is set to 0, no Worktop shortcut is
created on the desktop automatically.

TIP
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Optimizing performance: Worktop mirrors
The Worktop server is not much more than a distributor of all Worktop files. It
only shares the files needed by the Worktop clients, and therefore the hardware
specifications of the Worktop server are not the bottleneck, but rather the speed
of the network. For example, if you connect to a Worktop server located in the
Netherlands from your office in Japan, about 8 MB of data is transferred from
that server to your client. This only happens the first time if you run
Worktop_client.exe, or each time you run Worktop.exe. In both cases, this
amount of data is excessive.

To minimize the amount of data transferred over long distances, you can install
extra Worktop servers, or actually mirrors. End users can use this local Worktop
server to launch Worktop (Worktop.exe or Worktop_client.exe) while still using
the Worktop documents located on the central Worktop server (see transparency
of documents). In this case, only the Worktop document is sent over the long
distance, which is only a few Kbytes (about 50 Kbytes is already a large
document).

Note that the Worktop mirror only prevents Worktop-related files from being
sent over a long distance. This does not apply to BW-related files. To prevent
BW-related files from being sent over long distance, refer to the following
section.

Optimizing performance: Baan Windows
If you have a local Baan Windows installation of the same version as used by the
Worktop server, Worktop automatically uses the local installation instead of
loading the BW-related files from the server. This reduces network traffic.

To use multiple Worktop servers
You can run a Worktop client from multiple Worktop servers at the same time.
However, Baan does not recommend this. If you do so, and two BWC files have
the same name on two different Worktop servers, this gives a conflict. They are
both registered under the same name on the client, one overwriting the other.

To use Worktop locally and centrally
You can both have Worktop locally installed and run the Worktop client from a
different Worktop server. However, Baan does not recommend this. Two remote
BWC files with the same name, but located on different machines give a conflict
on the Worktop client.
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Global access
Worktop 2.1 supports global access, however this only applies if roaming
profiles are used (which is supported on Windows NT and 2000). As Worktop
writes the personalized documents to the users profile, global access is supported
when it is roaming.

To broadcast messages
You can broadcast messages to all users with Worktop. To broadcast a message,
simply put a raw text file with the name �message.txt� in the
%WORKTOPROOT%\msg directory. Each user automatically receives this
message in a dialog box that appears in front of all other Windows, with a
maximum delay of 15 seconds. Note that messages are displayed only once.
Worktop compares the last modified date of the message.txt file with the last date
on which it displayed a message to the user to check whether a new message
arrived.

To check for new messages each 15 seconds is set to default. However, you can
also disable this. By default, the AutoMessage field equals 1. If this field is set
to 0, the Worktop clients never check the Worktop server for new messages.
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To uninstall Worktop, make sure the Worktop application is closed. On the Start
menu, point to Settings, and click Control Panel, double-click Add\Remove
programs. Select Baan Worktop and click Add/Remove. A dialog box
appears, and then you can click Yes to uninstall Worktop.

Note that the uninstall does not delete any Worktop documents, log files, or any
files created after installation. Therefore the Worktop directory then still exists
after you uninstall.

5 To uninstall Worktop 2.1
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1 I installed Worktop 2.1. If I create a new document and select my bwc file, I
get the following error message, �You are not authorized to use any of the
main Worktop components. Contact your administrator.�

The User Data session on the ERP server (ttaad2500m000) defines to what
Worktop components you have access. This message appears if you do not
have access to any of the available components. If so, open the details of the
Baan user account you want to use in Worktop in the User Data session. On
the Startup Program tab, in the Worktop Tree group box, you can define to
what components this user has access. Note that after each change, you must
select Convert Changes To Runtime DD from the Specific menu of the
User Data session. Furthermore, after each change, make sure that the b-shell
is closed before you retry to create a new document. For more information,
refer to �Preinstallation steps� in Chapter 2.

2 If I open a Worktop document on the Worktop client, I directly get the
Connection Failure message.

Various configuration issues can cause this problem. To get an indication of
what is wrong, the log file on the Worktop client (located in the Application
Data\Baan\Worktop\log directory of the users profile) most likely provides
useful information. If you get the Connection Failure message directly, the
BWC file used by the document is almost certainly not registered correctly on
the client. Make sure that you have local administrator rights or that the
administrator opened this document before on this machine. Also, validate
whether the .sct file to which the Worktop document refers points to a valid
and BWC file that is registered correctly. Make sure you did not move,
delete, or rename BWC files outside BECS. This causes the BWC file to be
registered incorrectly.

3 A third check box exists in the User Data session, namely, Baan Workflow,
but if I select it, nothing happens in Worktop.

Worktop 2.1 (and any later versions of Worktop) does not support Baan
Workflow. Ignore this check box.

6 Troubleshooting
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4 I get the following error message �Cannot create configuration object� on
the Worktop client.

This error is probably due to the fact that you did not copy the contents of
%WINDOWSROOT%\Baan \bin to %BWROOT%\bin. If this is the case,
the log file on the client states �BW pointed to not configured to be used in
Central Deployment environment.� To fix the problem, copy the contents of
%WINDOWSROOT%\Baan\bin to %BWROOT%\bin.

5 The BaanERP sessions on Windows 2000 appear behind Worktop.

This is caused by changed behavior of Windows 2000. You can use the
Microsoft Utility: TweakUI, which can be downloaded from the Microsoft
site and is also available in the resource kit. You can use this utility to reset
the Prevent applications from stealing focus option. This solves the
problem.

6 When I open a second Worktop document, the Login dialog box does not
appear. How can I log on with a different user?

You cannot. If you use the same BWC file in two Worktop documents and
you open them both, no log on or password is requested when you open the
second document and the program assumes you want to use the same Baan
log on that was used when you opened the first document. No work-around
exists for this.

7 I cannot broadcast messages. I put a message.txt file in the \msg directory but
nothing happens on the Worktop client.

Make sure that the file name is indeed message.txt. If you selected the Hide
extensions for known file types check box in Windows Explorer, a file can
have the name message.txt in Explorer while it really has the name
message.txt.txt.

8 The ENTER key is ignored after I typ a URL in the embedded Internet
Browser.

This bug occurs in Windows 95 systems with an old or no version of Internet
Explorer installed. This is caused by a bug in the common control dll of
Windows, called comctl32.dll. This file is distributed with Internet Explorer.
You can either upgrade your version of Internet Explorer to 4.0 or later, or
download a patch from the Microsoft site,
http://www.microsoft.com/msdownload/ieplatform/ie/comctrlx86.asp.

9 The Tabs on bottom and Tabs on top fields do not work at all.

This bug occurs in Windows 95 systems with an old or no version of Internet
Explorer installed. See previous item.

http://www.microsoft.com/msdownload
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10 I changed the share names of the BW or Worktop share, and now I have
trouble with existing documents.

As Worktop stores the UNC paths in the Worktop documents, the document
becomes unworkable if UNC paths Worktop stores are changed. Whenever
you change the share name of the BW share or Worktop share, you must
restart Worktop and recreate the Worktop documents.

11 The User Manual and the Online Help sometimes refer to BAAN IV. Does
Worktop support BAAN IV or not?

No, this release of Worktop does not support BAAN IV. BAAN IV support
will be addressed in a later version of Worktop.
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